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C H A P 

Problems Starting Up 

Problems 
Computer Won't Start Up or Restart 

Computer won't start up. 

Try these solutions: 

• Make sure your computer is getting power. (p. 7) 

• Make sure the monitor is properly connected and adjusted. (p. 8) 

• Increase the memory available for system software. (p. 10) 

• "Force" the computer to restart. (p. 14) 

• Make sure memory and expansion cards are installed correctly. (p. 16) 

• Replace the computer's backup battery. (p. 16) 

Unusual sound occurs when you try to start up the computer. 

Try these solutions: 

• Make sure external equipment is properly connected and turned on. (p. 8) 

• .Make sure memory and expansion cards are installed correctly. (p. 16) 

• Test and repair the hard disk. (p. 16) 

Computer won't restart. 

Try these solutions: 

• Make sure your computer is getting power. (p. 7) 

• Quit open applications. (p. 7) 

• Make sure you're using the correct disk as a startup disk. (p. 12) 

• Resolve system extension conflicts. (p. 12) 

• "Force" the computer to restart. (p. 14) 

• Reset the PRAM. (p. 15) 
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2 Chapter 1 

Single Icon Appears in Middle of Screen 

Disk icon with blinking question mark appears. 

71J' tbese solutions: 

• Make sure external equipmenr is properly connected and turned on. (p. 8) 

• Resolve SCSI ID confiicrs. (p. 10) 

• "Re-bless" the System Folder. (p. 11) 

• Resolve system extension confiicts. (p. 12) 

• Reset the PRAM. (p. 15) 

• Test and repair the hard disk. (p. 16) 

• Reinstall system software. (p. 17) 

Disk icon with X appears. 

71y Ibis solution: 

• Make sure you're using the correct disk as a startup disk. (p. 12) 

"Sad Macintosh" icon appears. 

7iy tbese solutions 

• Make sure external equipmenr is properly connected and turned on. (p. 8) 

• Make sure you're using the correct disk as a startup disk. (p. 12) 

• 1est and repair the hard disk. (p. 16) 

• Reinstall system software. (p. 17) 

Computer Freezes 

Computer freezes before "Welcome to Mac OS" appears. 

Note: Startup may take several minutes on computers \\~th large amounts of RAI\1 because of 
the time it takes to verify that the RAM is functioning properly. 

71y tbese solutions: 

• 'Iake nares. (p. 6) 

• Make sure external equipment is properly connected and turned on. (p. 8) 

• 'Jest and repair the hard disk. (p. 16) 

• Reinstall system software. (p. 17) 



Computer freezes as icons are appearing at bottom of screen. 

7i~y tbese solutions: 

• Take notes. (p. 6) 

• Make sure external equipment is proper!)' connected and turned on. (p. 8) 

• Resolve system extension conflicts. (p. 12) 

• Test and repair Lhe hard disk. (p. 16) 

• Reinstall system software. (p. 17) 

Keyboard or mouse doesn't work. 

11-y tbese solutions: 

• Make sure external equipment is properly connected and wrned on. (p. 8) 

• Resolve system extension conflicts. (p. 12) 

• Test and repair the hard disk. (p. 16) 

• ReinsraU system sof(Ware. (p. 17) 

Message Appears 

Message about system software appears. 

'fiy tbese solutions: 

• Take notes. (p. 6) 

• Make sure you're using the correct disk as a startup disk. (p. 12) 

• Reinstall system software. (p. 17) 

"Not enough memory" message appears. 

Note: These solutions are for system software memoty problems. For problems with 
application memory, see "Problems With Applicat ions, Documents, and Memo1y" in Chapter 2. 

'J1y tbese solutions: 

• Increase the memory available for system software. (p. 10) 

• Resolve system extension conflicts. (p. 12) 

Disk corruption message appears. 

Tly tbese solutions: 

• Take notes. (p. 6) 

• Check RAM disk settings in the Memory control panel. (p. 10) 
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4 Chapter 1 

Message about the LocaiTalk port appears. 

7iJ' tbese solutions: 

• Make sure external equipment is properly connected and turned on. (p. 8) 

Normal Desktop Doesn't Appear 

Screen is dark. 

7iJ' 1 bese solu lions: 
• "Wake up'' your computer. (p. 6) 

• Make sure your computer is getting power. (p. 7) 

• Make sure the monitor is properly connected and adjusted. (p. 8) 

• Reset the PRAM. (p. 15) 

No icons appear in windows, and pointer alternates between an arrow and a 
wristwatch. 

1iy Ibis solution: 

• Reset the window display. (p. 11) 

Empty flashing box appears. 

Tly tbese solutions: 

• "Re-bless" the System Folder. (p. 11) 

• Reinstall system software. (p. 17) 

Large folder-shaped areas containing pictorial buttons appear. 

Tly ibis solution: 

• Make sure you're using the correct disk as a startup disk. (p. 12) 

Hard Disk Icon Doesn't Appear on Desktop 

Tly these solutions: 

• Restart your computer. (p. 6) 

• Make sure external equipment is properly connected and turned on. (p. 8) 

• Resolve SCSIID conflicts. (p. 10) 

• Test and repair the hard disk. (p. 16) 



Computer Starts Up From Wrong Disk 

Tly tbese solutions: 

• Make sure external equipment is properly connected and turned on. (p. 8) 

• Resolve SCSI 10 conftim. (p. 10) 

• i'.iake sure you're using the correct disk as a starrup disk. (p. 12) 

• Reset the PRAM. (p. 15) 

• Test and repair the hard disk. (p. 16) 

PowerBooks: Sleep Indicator Light Glows Steady Green 

Try tbese solutions: 

• Nlake sure your com purer is getting power. (p. 7) 

• "Force" the computer to restan. (p. 14) 

Problems Starting Cp 5 



6 Chapter 1 

Solutions 
Take notes. 

If you see an error message or the screen freezes, you don't have to take action immediately. 
First, note the following information: 

• rhe error message and irs ID number (if any) 

• what you were doing when the problem occurred 

• the programs you were using 

• software you have installed recemly (especially items that have been added to rhe 
System Folder) 

• dues on the screen- is a menu selected? \'V'hat programs and document icons are open? 

• anything else that seems relevant 

If you were typing text, write clown any text still visible on the screen so that some of your 
work will be easy to replace. 

Return to tbe "Problems" section on pages 1-5. 

''Wake up" your computer. 

If your screen is clark, a screen saver program may have darkened your screen, or the 
computer or monitor may have "gone m sleep" (to save energy) because it was inactive. Try 
the following: 

• Turn off the screen saver by pressing a key or moving the mouse. 

• "Wake up" your computer by pressing the Power key (marked with a <;J) on the keyboard. 

Jftbis doesn't solve your problem, retumto the "Problems" section on pages 1-5. 

Restart your computer. 

Often you can eliminate a problem simply by restarting your com purer, which dears the 
computer's memory. 

1 If you can, save an>' open documents before restarting. 

If your system is frozen or if you have a bomb message on the screen, saving may not be 
possible. You can try pressing Command (~)-period to cancel the current operation; if this 
works, you can then save the open documents before restarting. 



2 If you can, choose Restart from the Special menu or from the dialog box that's on screen. 

If the computer freezes after you choose Restart, see "Quit Open Applications," next. 

3 If you can't d1oose Restart, press the Power key (marked with a <J) on the keyboard. 

Click Restan in the dialog box that appears. 

4 If the Power key doesn't work, force a res tan b~· holding down the Command (~) and 
Control keys while you press the Power key. 

5 If your computer still doesn't res tan, turn off your computer using the power switch. If this 
doesn't work, or if your computer doesn't have a power switch, unplug your computer. 

6 Wait at least 30 seconds, then reconnect the power plug (if necessary) and turn your 
computer on again by pressing the Power key on the keyboard. 

If tbis doesn't solve yow· problem, retum to the "Problems" section on pages 1-5. 

Quit open applications. 

When you restart your computer, the computer tries to quit all open applications. Sometimes 
an application doesn't get the message w quit and ~·ou have w quit the application yourself. 
You can quit almost any application by choosing Quit from the File menu or pressing 
Command (~)·Q. 

If this doesn't work, you can sometimes "force" a program to quit by simultaneously pressing 
the keys Command (~). Option, and Esc. Then click Force Quit in the dialog box that appears. 

Note: Unsaved changes in your current documents .... ~u be lost. 

Immediately save all open documents, quit all other open programs, and restart your computer: 

If this doesn't solve yow· problem, return to the "Problems" section on pages 1-5. 

Make sure your computer is getting power. 

• Check that the keyboard and mouse cables are properly connected, including ADB cables 
you may be using berween the moniwr and the computer. 

Warning Make sure you turn off your computer before connecting or disconnecting 
keyboard and mouse cables. 

• Check that the power cord is plugged into a working outlet. If it's plugged into a power 
strip, make sure the power strip is turned on. 

Problems Sraning Up 7 



8 Chapter 1 

• Power Books: Make sure the battery is properly seated in its companmem. If the battery 
needs recharging, plug the power cord into a working outlet and then plug the power 
adapter into the computer. Let the battery recharge for a few minutes. 

• PowerBooks: If you're using the power adapter, it should get warm after being plugged in 
for 10 minutes. If it remains cold, make sure the adapter is securely plugged in and 
au ached to the power cord. 

{(Ibis doesn't solve your problem, return to tbe "Problems" section on pages 1-5. 

Make sure the monitor is properly connected and adjusted. 
• Check that the monitor's brightness (·:9:·) and contrast (<1) controls are adjusted properly. 

• '1\.Jrn off your compmer. For external monitors, check tim the monimr cable is firmly 
connecced to botl1 tl1e computer and the monitor, and that the monitor is plugged in and 
turned on. 

Warning Make sure you turn off both your computer and all e.xternal equipment 
before connecting or disconnecting equipment. 

• If possible, borrow a monitor that you know works with another Macintosh computer and 
connect it to your computer. If the borrowed monitor works, then your monitor may 
need repair. Consult an Apple-authotized service provider. 

Note: If you are displaying video from your computer on a television screen, it may be 
normal for your computer monitor Lobe clark. See your compmer's setup manual for 
information about connecting a television to your computer. 

lftbis doesn't solve your problem, retum. 10 tbe "Problems" section on pages 1-5. 

Make sure external equipment is properly connected and 
turned on. 

Warning Make sure you turn off both your computer and all external equipment 
before connecting or disconnecting equipment. 

• Shut down your computer by pressing the Power key (<I) and then clicking Shut Down. 
Make sure all external devices are properly connected and turned on. Check the following, 
then res tan your computer: 

• make sure connectors are plugged in all the way 

• make sure thumbscrews are secure 



• make sure terminators are secure and their clips are fastened 

• remove devices (especially SCSI devices) tim you do not use 

• remove SCSI-1 devices if you are also using SCSI-2 devices (Older disks, usually under 
200MB in size, can cause problems when they are connected ro a SCSI bus to which 
SCSI-2 cle,~ces are also connected.) 

• If that doesn't work, then shut clown your computer again. Turn off and disconnect all 
external equipment (except your monitor and keyboard). Then restart the computer. lb 
determine which piece of equipment is causing the problem, reconnect them one by one, 
turning off your computer before connecting each device. Starr up your \'lacintosh each 
time until the problem recurs. When you determine which piece of equipment is causing 
the problem, refer to the manual that came with the equipment, as well as the information 
on connecting equipment in the setup manual that came with your computer. 

Note: If you have a printer connected to your computer's SCSI port, make sure your 
ptinter is connected properly. )·lost primers connect ro the printer port, not the SCSI 
port. Check the manuals that came with your printer for information on how to connect 
it properly. 

• If you are connected to an Ethernet network, your computer may nor stan up due to 
heavy network trafllc. Disconnect the Ethernet cable, then stan up again. Reconnect the 
Ethernet cable after the computer starts up. (It's okay to connect and disconnect an 
Ethernet cable while your computer is on.) Check the senings in the AppleTalk comrol 
panel ro make sure that Ethernet is still selected. 

• If you suspect a keyboard or mouse problem, shut down your computer. Clean your 
mouse as described in the setup manual that came with your computer. Borrow a 
Macimosh keyboard or mouse from another computer and connect it to yours. If that 
solves the problem, you may need to repair your keyboard or mouse. Consult an Apple
authorized service provider. 

If tbis doesn't solve yow· problem, return to tbe "Problems" section on pages 1-5. 
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10 Chap1er I 

Resolve SCSI ID conflicts. 

Each SCSI (Small Computer System Interface) device connected co your computer must have 
a unique ID number, from 0 co 7. If }'OU have external SCSI devices (such as disk drives), 
make sure they don't have the same ID number as one another or as SCSI devices inside 
your computer. I merna! SCSI devices typically have the following IO numbers: 

l-Iard disk 0 

CD-ROM drive 3 

Zip drive 5 

Macintosh com purer 7 

Note: Some com pUlers have two separate SCSI chains, each with irs own set of 10 numbers. 
Also, some computers have an A'!). or IDE hard disk drive, which is not pan of the SCSI chain 
and therefore does nor have a SCSI 10 number. See the technical information booklet and 
the setup manual that came with your computer . 

.VIake sure that the SCSI chain is properly terminated. In general, the first and last device of 
each SCSI chain must be terminated. 

See your computer's setup manual and the documentation that came with your SCSI 
equipment for specific details on setting SCSI 10 numbers and terminating SCSI devices. 

If Ibis doesn't solve your problem, return to tbe "Problems" section 011 pages 1-5. 

Check RAM disk settings in the Memory control panel. 

If you're using a RA.t\1 disk and you get a disk corruption message, click Cancel to close the 
message. Check the RAM disk settings in the Memory control panel to make sure that you 
aren't trying ro create a RAM disk larger than the t~moulll of free space on your hard disk. 

Iftbis doesn't solve your problem, retumto tbe "Problems" section on pages 1-5. 

Increase the memory avallabl for system software. 

If you're having trouble starting up yow· computer, there may nor be enough memot'}' to 
load all the system sof1ware extensions you've ins1alled. Restart the computer, holding down 
the Shift ke}' until you see the message "Extensions Dist~bled" in the "Welcome to Mac OS" 
box. Then try the following: 

• 'Jbrn on (or increase) virtual memory in the Memory control panel. Your computer will 
perform well \Vith virtual memory set up to twice I he amount of RAM in the computer; for 
best performance, limit virwal meinory ro 1.5 times the amount of RAJ\t 



• Reduce the size of the disk cache in rhe Memory comrol panel. 

• If you use a RAM disk, reduce its size or turn it off in the Memory conrrol panel. 

• Use the E'\tensions ~1anagcr comrol panel to turn off extensions you don't need. (You can 
use the Extensions Manager ro create different sets of extensions for special situations.) 

You need ro restan the computer for these changes to rake effecr. Sec .'l'lac OS Help 
(avai lable in the Help menu) for more information about using virtual memory, a RAM disk, 
and the Extensions Manager. 

If the problem persists, try performing a clean installa tion of system software. See Chapter 5, 
"Reinstalling Your Computer's Software." 

If none of these suggestions work, install additional RAM in your computer. See the setup 
manual that came with your computer. 

If this doesn't solve yourpro/Jiem, ret 11m to tbe "Problems" section on. pages 1-5. 

Reset the window display. 

There may be a problem wi th the display of the windows. Restart the computer and hold 
down the Option ke~' until rhe desktop icons appear. (\X'hen the deskrop appears, all 
windows will be closed.) 

if tbis doesn't solueyour problem, retum to tbe "Problems" section 011 pages 1-5. 

"Ae·bless" the System Folder. 

If your computer is nor recognizing the sysrem software, the System Folder may need to be 
"re-blessed." 

1 Stan up your compu ter from the system sofl\vare CD. 

See Chapter 3, "Starting Up From a CD or Floppy Disk." 

2 Open rhe System Folder. 

3 Double-dick the System suitcase. 

4 After the System suitcase opens, close rhe suitcase and System Folder windows and restart 
your computer. 

If this doesn't work, then try the following: 

1 Drag the System suitcase and f-inder om of the System Folder. 

2 Close the System Folder. 

3 Pm the System suitcase and Finder back into the System Folder. 

{( tbis doesn't solve your problem, retum to tbe "Problems" sectio11 011 pages 1-5. 

Problems Staning l: p 11 



12 Chapter I 

Make sure you're using the correct disk as a startup disk. 

At least one disk drive must have system software on it from which the computer can start 
up. Most computers have an internal hard disk that is used as the startup disk. If the stan up 
disk is an external hard disk, check that it is turned on and that irs cable is connected firmly. 
Then restart the computec 

Serve1:<;: If the hard disk has been ini tialized for use as a RAID volume, you won' t see an icon 
for it on the desktop until you create at least one RAJD volume on that disk. Refer to the 
manual that came with the RAID software for more information. 

Iflarge folder-shaped areas comaining pictOrial buttons appear when you starr up, you 
probably started up from a CD containing At Ease, an alternative to the Macintosh desktop. 

You can specify the startup disk by using the Startup Disk control panel. See Mac OS Help 
(available in the Help menu) for inmuctions. 

Floppy disk: If your computer is trying to stan up from a floppy disk that doesn't contain 
system software, an icon wid1 an X in it appears on your screen. After a few seconds, the 
computer should eject the disk and starr up from your hard disk. If this doesn't work, see 
"Disk Is Jammed" in Chapter 2. 

CD-RO.M or D\fD disc: If your compmer is trying to starr up from a CD or OVD, press the 
Open/Close button of your drive to open the tray, then remove the disc. Close the tray and 
restart your computer. 

Note: If your computer started up from a CD, the elise will not be amomatically ejected 
when you shut clown. Restart the computer while pressing the Open/Close button of the 
drive. The tray should open so you can remove the disc. If the tray won't open, see "Disk Is 
Jammed" in Chapter 2. 

{{Ibis doesn't solve yow· problem, retum to tbe "Problems" section on pages 1-5. 

Resolve system extension conflicts. 

If your com purer does nor stan up properly or behaves erratically, you may have an 
extension or control panel that is not compatible with another extension or control panel, or 
with an application or system software. 

Verify the problem 

To verify that you have a compatibility problem: 

1 Start up you r computer while holding clown the Space bar. 

This opens the Extensions Manager conrrol panel. 



2 Release the Space bar when the Extensions Manager control panel opens. 

~ """' =-~-"' Extensions ~nager ,..= = ~ - (;!] 13 

Selected Set I i MacOSO.Iall ¢) ~ 
On/Off Stze I Yenion I PactctQe ... 

v[8) Gl Cootrol Panels 5,184K -
[81 ~ Appearance 240K 1.0.1f1c2 Moe OS e .••• ~ 
[81 !!iJ Apple Menu Options 56K 1.1.3 Moe OS e.o 

[81 ~ ApploTolk 216K I. I Open Tron ... 

[81 j!3 Cache Svltch eK 7.0.1 Moe OS 8.0 

li!l 1!1 ColorS~nc .. m Profile 16K 2 1 Moe OS 8.0 

[i!) ~ Dete&Time 80K 8 O. lbS Moe OS e .... 

[i!) !B!j Dosk:fop Pfcturoo 832K 1.0. 1 Moe OS 8 .... 

[81 1m Ffto 9hor1"l 640K 8.0 11oc OS 8.0 

00 E!J Gonerel Conlrole 64K 7.7 Moe OS 8.0 . 
[)> Shov Item lafor•etton 

1 Re stnrt ) I Re.;e;:r-1 1 Duplicate Set ... ) 

I@ 

3 Notice the name of the currently selected set of extensions in the Selected Set pop-up menu 
so that you can return to it later if you want. 

4 Open the Selected Set pop-up menu and choose the "Mac OS 8.1 base·· set. 

This makes the computer start up using only the software installed at the factory. 

5 Click the Continue bunon to continue startup. 

6 When the computer is ready, try the same a([ions that caused the problem. 

If the problem no longer occurs, you probably have one or more extensions or control 
panels that don't work with Mac OS 8. 1. Continue with the steps that follow in "Test 
Individual Extensions and Control Panels." 

Test individual extensions and control panels 

1 Restan your computer while holding down the Space bar. 

2 Release the Space bar when the Extensions Manager control panel opens. 

3 Click the Duplicate Set button to create a new set. In the window that appears, type a name 
for the set (for example, "Test Set") and click OK. 

4 'll•rn off all the extensions in the new set by choosing '1\11 Off" in the Edit menu. 

5 '1\.Jrn on the item yotl want to test by clicking its checkbox. 

6 Click the Continue button to continue stanup. 

Problems Starring Up 13 



14 Chapter l 

7 Try the same actions that caused the problem. 

If the problem occurs again, the item is probably incompatible. Remove the item from the 
Extensions folder or turn the item ofT using the Extensions Manager. 

8 Hepeat steps 1 through 7 for each item you want to test. 

If you find that a piece of software is incompalible, contact the manufacturer of the software 
to see if an updated version is available. 

Tips: A recently installed extension or control panel might be the problem. If you have a lot 
of extensions and control panels, you may want to "work by halves." Turn on half the 
extensions and control panels and test for the problem. If the problem disappears, repeat the 
process turning on half of the rem(l ining items. If the problem persists, repeat the process 
turning off half of the items that <u·e turned on. Continue to work by halves like this until you 
locme the conflicting extensions or control panels. 

(/Ibis doesn't solve your problem, retumto the "Problems" section on pages 1-5. 

"Force" the computer to restart. 

Press the Command (:lf:), Control, and Power keys simultaneously. 

Important Force a restart only when the normal Restan command (in the Special menu) 
does not work. 

Note: \X~1en you force a restart, the computer thoroughly rests the RAJvl. It may take a few 
moments (about 1 second per megabyte of RAM) before the screen image reappears. 

If the forced restart doesn't work, usc rhe power switch (marked with the icon Q)) to turn off 
your computer. If your computer doesn't have a power switch, unplug the computer. 

PowerBooks without a reset bullon: Simultaneously press the Shift, Function, and Control 
keys and the Power button to restart. 

Wait 30 seconds, then plug the computer back in, if necessary, and restart by pressing the 
Power key (marked with a <l) on the keyboard. 

Ift!Jis doesn't solve your problem, return to the "Problems" section on pages 1-5. 



Reset the PRAM. 

Your computer stores information in an area of memory called parameter RAM (PRAM). 
Resetting the PR!\lvl replaces the information stored there with the default (original) settings. 

When you reset the PRAM, preferences for serial ports, '~deo, and sound are lost. This affem 
the settings in some of your control panels, including the following: 

• Memory (information lost includes RAM disk settings) 

• Monitors & Sound 

• Keyboard and Mouse (or Trackpad) 

• AppleTalk ("Connect via" is set to the printer port) 

• Power Manager 

• Map 

You may want to make a note of the settings in these control panels before resetting PRAM. 

Some third-party software programs also store information in PRAM. Some video cards may 
need to be reconfigured after reseuing PRAM, and other aspects of your work may be affected. 

Follow these steps to reset the PRfuvl: 

Note: This procedure ma}' not work with some keyboards from manufacturers other than 
Apple. 

1 Shut down your computer by pressing the Power key (<J) and then clicking Shut Down. 

2 Make sure the Caps Lock key is not engaged. 

3 Position the fingers of your left hand on these keys: Command (~).Option, and R. Locate 
the P key, so you can find it quickly for step 4. 

4 Press the Power key (<J) to turn on your computer. Immediately after you hear the startup 
sound, press and hold down the Command (~) . Option, and R keys at the same rime you 
press and hold down the P key. 

5 After you hear the startup sound a second time, release the keys. Then immediately press 
and hold down the Shift key. Release the Shift key when you see the message "Extensions 
Disabled" in the "Welcome to Mac OS" box. 

If you don't see the ·'Extensions Disabled'' message, wait until startup is complete. Then 
press and hold down the Shift key while you choose Restart from the Special menu. 
Continue to hold down the Shift key until the message appears. 

6 Open the System Folder, then open the Preferences folder. 

i>roblems Starting Up 1 5 
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7 Drag the Display Preferences icon to the 'll·ash. 

~ 
~ 

Display Preferences 

a Rest:ltl your computer without holding down the Shift key. 

The computer starts up with your extensions wrned on again. 

9 If you had special settings in any control panels, open those control panels to restore the 
senings you wam. 

If this doesn'l solve your problem, return to the "Problems" section on pages 1-5. 

Make sure memory and expansion cards are installed 
correctly. 

If you recently installed RM·t or an expansion card in )'Our computer, check the installation 
information in the setup manual that came with your computer to make sure the card is 
properly installed. If you purchased an expansion card from a manufacturer other than 
Apple, contaCt the manufacwrer if you need further help. 

If this doesn't solve your problem, return to the "Problems" section on pages 1-5. 

Replace the computer's ackup battery. 

l f you have intermittent problems starling up your computer and the dme is reset to 1956, 
have an Apple-authorized service provider replace the battery. See the setvice and support 
information dm came with your compmer. 

lftbis doesn't solve your problem, return to tbe "Problems" section on pages 1-5. 

Test and repair the hard disk. 

Follow the instructions in Chapter 4, ""Iesting and Repairing Your l-Iard Disk." 

lftbis doesn't solve yow· problem, return to tbe "Problems" section on pages 1-5. 



Reinstall system software. 

Follow the instructions in Chapter 5, "Reinstalling Your Computer's Sofrware."' 

Note: If you see a message about system software immediately after you did some "house 
cleaning" on rour computer, you may have inadvertently removed the system enabler file 
from the System Folder. If you didn't throw the enabler away, you may be able ro repair your 
system by dragging the file back into the System Folder. 

1 Starr up your computer from the system sofrware CD or floppy disk, as described later in 
this handbook. 

2 Locate the enabler file. The system enabler is usually named "System Enabler <version 
number>." For PowerBooks, look for ·'PowerBook <version number> Enabler.'' 

3 Drag the system enabler onto the System Folder. 

4 Restan your computer. 

fltbis doesn't solue your problem, retumto the "Problems" section on pages 1-5. 
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Where to Find Onscreen Help 

Mac OS Help 

Step-by-step instructions for using the Mac OS are available from Mac OS Help. 

To open the help system, 
choose Help fromtbe 
Finder's Help menu. 

Mac OS Info Center 

OK 

The Mac OS Info Cemer contains information about your computer and the Mac OS, 
including troubleshooting information. 

Nac OS Info Center 

Double-click tbe Mac OS Info 
Center icon on your desktop 
to open the Info Cente1: 

Click this button to see -----i 
troubleshooting infot7nation 
and links to Apple's online 
support \Veb sites. 

TIPS AtiD SITES FOR MAKif4Q THE MOST OF YOUR COMP U TE R 

~ Mac"OS 

InfoCenter 
You don't nood nn lntornot connection to uao tho Info Center. 

Click a picture bolnw to get stortod. 



C H A P 

Problems Using Your Computer 
Problems With Applications, Documents, and Memory 

"Not enough memory" message appears. 

There is not enough memory avllllllble to 
continue. Use the Appliclltlon menu to quit 
some 11pplicot1ons, then click Try Agnin. 

If quitting npplicatlons does not help, quit 111i 
IIPPiications and click Restart. 

( Restort I ~ Try Ag11in D 

All the memory in your Macintosh is in use by other application programs, system software, 
and system resources. 

• Quit other open programs m free memory, then open the program you want to use. 

• Follow· these steps to allocate more memory to the program: 

1 Choose About This Computer from the Apple (ti) menu. Take note of the number in 
the Largest Unused Block section. This number tells you how much memoq' is 
available to open programs. 

2 Quit the program if it's open, select its icon, and choose Get Info from the File menu. 
Take note of the numbers in the Minimum Size and Preferred Size boxes. 

3 If the number in the Minimum Size box is larger than the largest unused block, nor 
enough memory is available to use this program. To free memory, quit open programs 
or restart the computer. You can also rype a smaller number in the Minimum Size box 
if you want to open the program using less memory. But some programs don't work 
well if you assign them less memory. 
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4 If the number in the Preferred Size box is smaller than rhe largest unused block, you 
may need ro assign more memory to the program. (A program may need more 
memory if you are working with complex documents.) Type a larger number in the 
Preferred Size box. 

• Use the Memory control panel to reduce the size of the disk cache, remove or reduce the 
size of your RAM disk, or turn on virtual memory. for more information, use Mac OS Help 
(choose Help from the Finder's Help menu). 

Note: I f you are using a Power Macintosh MP model, you may not want ro turn on virtual 
memory. For more information, see the setup manual that came with your computer. 

Note: If )'OU have both virtual memory and a RAM disk turned on in the Memory control 
panel, don't set both of them at or near their maximum values. Doing so can result in 
unpredictable or reduced performance by your computer. (A RAM disk uses random
access memory, or RAM, as if it were a hard disk.) 

• Disable system extensions tim you don't need. For more information, see the topic on 
system extensions in Mac OS Help (choose Help from the Finder's Help menu). 

• If you have installed system software additions from the Apple Extras folder, you may want 
to remove them if you are not using them. (This software can decrease the amount of 
memory available for use by application programs.) To remove a system software 
addition, run the system software Installer and follow the steps for a custom installation. 
See Chapter 5. 

• If you frequently want to open more programs than memory allows, you may want to install 
more random-access memory (RAM). See the setup manual that came with your computer. 

Computer ''freezes." 

• Your computer may be trying to complete a task, but it's taking so long that it seems that 
the screen has frozen. If you need tO do something else instead, try simultaneously 
pressing the Command (:te) ker and the period key (.) to cancel the task the computer is 
working on. 

• There may be a temporary software problem that can be fixed by restarting your 
computer. See "Resrart Your Computer" in Chapter 1. 

If the problem recurs, it may invoh'e one or more of your application programs. See the next 
enu·y for additional suggestions. 



Software quits unexpectedly. 

The application "unknown" hos 
une Hpectedly quit, becouse on error of 
type 1 occurred. 

C§Ol j 

The application program needs more memory, or there is a software problem. 

• Write down what you were doing when the message appeared, and write down the text of 
the message. This information may help a technical support representative diagnose your 
problem if you later need to contact Apple or the manufacturer of the application program. 

About the codes in error messages: The number codes in error messages are used in 
software development. Sometimes they can help a technician narrow clown the source of 
a problem. However, the codes are usually too general or technical in nature to help you 
diagnose a problem yourself. 

• Restan your Macintosh. (See "Restart Your Computer" in Chapter 1.) Most software 
problems are temporary, and restarting the computer usually corrects the problem. 

• Check for multiple System Folders on your startup disk, using the Find File command. 
Throw away extra System Folders. The System Folder that your computer is using has the 
Mac OS icon on it, which distinguishes it from any orher System Folder. 

Sys~em Folder 

• Check for viruses on all your disks, using a virus-detection program. Eliminate any viruses 
the program finds. 

• Use the program's Get Info window to give it more memory. (Select the program's icon 
and choose Get Info from the File menu.) See '"Nor Enough J\llemory' Message Appears" 
ar the beginning of this chapter. 

• If the problem occurs when you are trying to print, there may nor be enough memory for 
printing. Quit other open programs to free memory. 

• If the problem only occurs in one application program, check for multiple copies of the 
program on your hard disk. Use the Get Info command to check the programs' version 
numbers. Keep one copy of the latest version and throw away all other copies. 

Also, try reinstalling the program from the original disks. I f reinstalling doesn't solve the 
problem, contact the manufacturer of the program to see if the program contains software 
errors or "bugs" and if it is compatible with the version of system software you're using. 
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• Sometimes incompatible system extensions or control panels can cause S)'Stem software 
problems. Restan while holding down the Shift key; this temporarily turns off all 
system extensions. 

If your computer works normally after you do this, use the Extensions Manager control 
panel (in the Control Panels folder in the Apple [tl] menu) to turn on extensions and 
control panels one at a time. Restart after you turn on each extension and comrol panel. 
This procedure should idemify incompatible extensions and control panels. (If you just 
added new software to your computer, its system extension is the most probable cause of 
the problem.) See "Resolve System Extension Conflicts" in Chapter 1. 

lf your computer performs better when a particular extension or control panel is turned 
off, contact the software's manufacturer for information or an upgrade. 

• Reduce the number of active fonts in your system by moving fonts from the Fonts folder 
to another folder [such as "foonts (Disabled)"]. Then restart your computer. 

• If the problem recurs, you may need to reinstall system software. See Chapter 5, 
''Reinstalling Your Computer's Software,·· for instructions. 

Application won't open. 

• The application program may already be open. Check the Application menu to see which 
programs are running. 

• There may not be enough memory available to open the program. Quit any programs 
you're not using and try again. If that doesn't work, try restarting the computer. 

You can also use virtual memory to make more memory available to your programs. You 
turn on virtual memO!')' in the Memory comrol panel. See the information about the 
Memory control panel in Mac OS Help (choose Help from the Finder's Help menu). 

• The program isn't requesting as much memory as it needs. Use the program's Get Info 
window to give it more memory. See '":.lot Enough Memory' Message Appears" at the 
beginning of this chapter. 

• If the program is on a floppy disk, make sure the disk is unlocked. (You unlock a disk by 
sliding the tab at the corner of the disk so that it covers the hole.) 

• The program may be damaged, or it may not be compatible with PowerPC'M technology. 
Check to make sure the software is PowerPC-compatible, and install it from a known good 
source (sud1 as the original program disks). 

• Check that the program is compatible with the version of system software that you are 
using. (See rhe program's documentation, or contact the manufacturer or vendor.) 



Application won't open because a file can't be found. 

Macintosh programs designed specifically for the PowerPC microprocessor (also called 
"native" applications) use special files called "shared libraries." Any necessary shared libraries 
should be installed automalically when you ins call these special Macimosh programs. 

Follo'v the directions that came with your program to reinstall it. If the shared library is still 
missing, contact the software program's manufacturer for assistance. 

Document won't open, or application program can't be found. 

The document may have been created with a program that is not on your hard disk, or with a 
different version of the program. 

• Try starting a program that you think might be able to open the clocumem. Then choose 
Open from the program's File menu w open the document. For more information, see 
the documentation that came with the program. 

• Purchase and install the correct software to use the document, or find out if the creator of 
the document can convert it to a form that one of your programs can use. 

• Rebuild your desktop. 'to rebuild the desktop, hold clown the Command (31:) and Option 
keys on the keyboard while ~·ou restart the computer. 

• Don't try w open the files in your System Folder: !'-•lost of the files in your System Folder 
are used by your computer for internal purposes and are not intended to be opened. 

• If the clocumem is from a DOS or Windows computer, see "DOS or Windows Document 
Won't Open, or Displays Incorrectly," later in this section. 

Document can't be saved. 

• A CD-ROM elise is a read-only medium. This means that information can be read 
(retrieved) from it, but nm written (stored) on it. You can save the changed information 
on a hard disk or floppy disk. 

"QuickDraw 3D could not be found" message appears. 

• Make sure that the following files are in the Extensions folder, inside the System Folder: 

• Quick Draw 3D 

• QuickDraw 3D RAVE 

• QuickDraw 3D Viewer 

• Quick Draw 30 IR 

If the files are there and you still get the message, it means that you don't have enough 
memory to run the application. You may be able to open the application if you try one or 
more of the following: 

• Quit other open applications. 
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• Reduce the amount of memory allocated to the application: 

1 Select the application's icon in the Finder. 

2 Choose Get Info from the File menu. 

3 Type a lower number in the box for Preferred Size. 

• Install more memory (RAM). 

DOS or Windows document w on't open, or d isp lays incorrectly. 

If you can't open a DOS or Windows document by double-clicking its icon, try one of 
the fol lowing: 

• Open 01e document from wit.hin the program by choosing Open in the program's file menu. 

• Use the PC Exchange control panel (in the Control Panels folder in the Apple !t11 menu) 
to specify which Macintosh program will open the document. 

If a DOS document is displayed incorrectly, or you see strange codes or characters in the 
clocumem, try one of the following: 

• Your application program may have spedal procedures for opening and saving documents 
with different file formats. See the information that came with your program, or call the 
program's publisher. 

• Try opening the document in another program. 

Note: Some characters that can be displayed on the Macintosh are nor accurately displayed 
on DOS computers. 

See information about working with DOS or Windows documents on your Macintosh in 
Mac OS Help (choose Help from the Finder's Help menu). 

Can't throw a w ay a file. 

• The file may be locked. Select the file's icon, choose Get Info from the File menu, and click 
ct1e Locked checkbox to remove the X. You can delete locked files that are in the Trash by 
holding clown the Option key while you choose Empty Trash from the Special menu. 

• An application program may be using the file. Close the file or quit the program. 

• If the file is on a Aoppy disk, the disk may be locked. Unlock the disk by sliding d1e tab so 
that it covers the hole at the corner of the disk. 

• The file may be in a shared folder that can't be changed. You can throw away the file by 
turning off file sharing temporarily (click Stop in the File Sharing control panel). Or you 
can select the shared folclei~ choose Sharing from the File menu, and uncheck the box 
labeled either "Can't be mm'ed, renamed, or deleted" or "Same as enclosing folde!:'' 



Older Macintosh programs don't work properly. 

Some older Macintosh programs are not completely compatible with Macintosh computers 
that have the PowerPC microprocessor. 

• ContaC[ the program's publisher to see if an upgrade is available. 

Window disappears. 

• Another open window may be coveting the one you're looking for . .\•love, resize, close, or 
hide windows until you see the one you want. 

• The program the window is associated with may be hidden. Choose Show All from the 
Application menu and then dick the window you want, or choose the program from the 
Application menu. 

Can't quit program opened from Launcher. 

Some programs in the Learning section of the Launcher (when you press the Learning 
category button) are self-running demos. If you can't get out of one of the programs or 
demos, try the following: 

• Look again to see if you can find a Quit button or other quitting option. 

• Hold down the Command (3€) key on your keyboard and, w·hile holding it down, press 
the period key. 

• While holding clown the Command (3€) key on your keyboard, press the Q key. 

• Press the Power ke}' (marked with a <J) on your keyboard and then press Return to shm 
clown the computer. 

• Restart your computer by holding down the Command (3€) and Control keys while you 
press the Power key (marked with a <J). 

Problems With Hard Disks, CDs, and Other Storage Media 

Disk Is Jammed 

The normal way to remove a disk from your computer is to select the disk's icon and choose 
Eject from the Special menu. You can also drag the disk's icon on the desktop to the Trash. 
Removable disks are usually ejected when you shut clown your compmer. 

Warning Turn off your computer before you anempt to remove a jammed disk. If 
you don't, you may damage the drive. 
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If a disk is jammed, shur down your computer. Locate the small hole near the disk drive's 
opening, and carefully insert the end of a large straightened paper clip. Push gently until the 
disk is ejected. Do not use excessive force. 

Zip disk: Use a small paper cl ip for built-in Zip disk drives. 

Problems With Hard Disks 

Files disappeared. 

If no fi les appear on the hard disk except for a single clocumem called "\Vhere have all my 
files gone?", the disk is formatted with Mac OS Extended format. (Mac OS Extended format is 
a new method of formatting hard disks that allows for more effkienr use of hard disk storage 
space.) To see the contents of a disk formatted with Mac OS Extended format, you must starr 
up your computer from a disk with Mac OS 8.1 system softv.·are. You can get Mac OS 8.1 from 
your Apple dealer or from the online Apple Store at www.apple.com. 

Can't mount Mac OS, DOS, or ProDOS partitions. 

• Use PC Exchange to mount these partitions as individual volumes on the deskrop. (PC 
Exchange is a control panel that is part of system software. When used wid1 a DOS
compatibiliry card and irs accompanying software, PC Exchange allows your Macintosh ro 
communicate with non-Macintosh software and hardware.) 

Note: If the disk contains both Mac OS- and DOS-format partitions, PC Exchange will 
recognize only the Mac OS partition. Also, PC Exchange can recognize ProDOS-format 
panitions on I)' on SCSI hard disks that are less than 32 .MB. 

Can't resize Mac OS, DOS, or ProDOS partitions. 

• To resize or reformat multiple Mac OS, DOS, or ProDOS partitions, you need to use third
parry software designed for partitioning hard disks and removable media carttidges. 

Problems With CD·ROM Drives and Discs 

Icon doesn't appear on desktop. 

• Make sure that the elise label is facing up and the elise is centered in the tray. 

Important If you're using a small (8 em) disc, make sure it's centered within the tray's 
inner ring and the computer is absolutely level. An improperly seared small disc in your 
computer may result in damage to the disc, the CD-ROM drive, or both. 



• Make sure the tray is closed all the way. 

• Try restarting your computer. 

• Make sure that the Apple CD-ROM and Foreign File Access extensions are turned on in 
the Extensions Manager control panel. (Open the Extensions Manager control panel in 
the Control Panels folder in the Apple [tl] menu). Then restart your computer. 

• The disc may use a format that the Macintosh cannot recognize. Ask the disc's 
manufacturer for a disc that a Macintosh can recognize. 

• Try starting up your computer from the system software CD that came with your 
computer. Insert the CD and restart while holding down the C key. (See Chapter 3, 
"Starting lp From a CD or Floppy Disk.") I f only the hard disk icon appears on the 
desktop, then there may be a hardware problem with your CD-ROM drive. If the CD-ROM 
disc icon appears above the hard disk icon, reinstall )'our CD-ROM software. The easiest 
way to do this is by reinstalling your system software. See Chapter 5, "Reinstalling 'tour 
Computer 's Software." 

• lf you have SCSI devices (anything connected to the SCSI port I~]) attached to your 
computer, make sure that each device has a unique SCSI lD number (your CD-ROM drive 
has SCSI ID 3). See "Resolve SCSllD Contlicts" in Chapter 1 and the documentation that 
came with your SCSI devices if you need to reset SCSI lD numbers. 

• If you inscallecl a CD-ROM drive after you bought your computer, make sure the CD-ROM 
software that came with the dtive is installed. See the manual that came with the CD-ROM 
drive. (The CD-ROM software is already installed on Macintosh computers that came with 
CD-ROM drives.) 

Disc is vibrating in the drive. 

Some CD-ROM elise labels h;we artwork that is noticeably thicker on one side than the other 
and can cause the elise's weight to be slighdy off-center. This uneven distribution of weight 
coupled with the high roration speed of your CD-ROM drive can cause some discs to wobble 
in the drive and make your computer vibrate. The vibration damages neither the CD-ROM 
disc nor the computer and affects very few CD-ROM discs. If you can feel or hear that the 
CD-ROM elise is vibrating in the computer, you don't need to do anything special; continue to 
use the CD-ROM elise as you normally would. 

Note: If you use a CD-ROM elise with a removable (stick)') label, remove the label before 
inserting rhe disc. 
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Tray w on't open. 

({a CD-ROM disc icon appears 011 your screen: 

• Select the disc icon anti choose Put Away from the r ile menu, or drag the icon to the 'Ji·ash. 

Note: You won't lose information on the CD by dragging its icon to the Trash. 

If the AppleCD Audio Player is active, choose Eject CD from the File menu or click the 
eject button in the AppleCD Audio Player conrroller. 

If you see a message that a disc can't be put away because it is being shared, turn file 
sharing off in the File Sharing control panel in the Conrrol Panels folder, available in the 
Apple (tl) menu. 

If 110 CD-R0,\11 disc icon appears 0 11 your screell: 

• Restart your computer. Immediately after you hear the startup chime, press the 
Open/Close buttOn of your CD-ROM drive. 

• The signal to open the tray may not be reaching the computer. 1vlanually remove the disc, 
as described in "Disk Is Jammed," earlier in this section. 

If neither of these suggestions works, your CD-ROM drive may be damaged. Contact an 
Apple-authorized service provider or Apple for further assistance. 

Can't eject disc. 

• If file sharing is on and you are having trouble ejecting a disc, turn file sharing off in the 
File Sharing control panel in the Control Panels folder, available in the Apple (tl) menu. 

"This is not a M acintosh disk: Do you want to initialize it?" message appears. 

• Make sure that the fooreign f ile Access extension is installed and turned on. Use the 
Extensions Manager control panel in the Control Panels folder in the Apple (tl) menu to 
turn it on, then restart your computer. 

• The elise may use a format that the Macinrosh cannot recognize. Ask the elise's 
manufacturer for a elise tim a Macintosh can recognize. . 

• Make sure the CD-ROM software is installed. (The CD-ROM software is already installed 
on Nlacimosh computers that come with CD-ROM drives.) The easiest way tO insrall 
CD-ROM software is by reinstall ing your system software. See Chapter 5. lf you installed a 
CD-ROM drive after buying your computer, see the manual that came with the drive. 
Restart your com purer after installing CD-R0J'.·I software. 



C om puter ejects disc unexpectedly. 

• J\llake sure the disc is lying A at in the tray and the disc label is facing up. 

Important If you're using a small (8 em) disc, make sure it's centered within the tray's 
inner ring and the computer is absolutely level. An improperly seated small elise in your 
computer may result in damage ro the disc, the CD-ROM drive, or both. 

• The disc may need to be cleaned. (See the sewp manual that came \vith your computer.) 
If there are visible scratches on the shiny side of the disc, you may be able to remove 
them with a CD-ROM disc polishing kit (available from your audio CD dealer) . If the 
scratches can't be removed, you need ro replace the disc. 

• The disc may be damaged. Try another elise in the drive, and u·y d1e original elise in 
another drive. If the original drive reads other discs or if the original disc also doesn't 
work in another drive, the disc is probabl)' damaged. You need to replace it. 

Problems Using ISO 9660 or High Sierra Discs 

Files can't be opened. 

• Discs in the ISO 9660 and High Sierra elise formats have version numbers attached to file 
names. Some application programs need these version numbers in order to work with 
Ales. To make the version numbers available to programs on your computer, drag the 
CD-ROM elise icon to the 1i·ash. When the tray opens, hold clown the Option key and 
push d1e tray back in. Continue w hold down the Option key until the elise is mounted 
in the drive. The program you are using should now be able ro locate file names on that 
CD-RON! elise. 

• Make sure that the Foreign File Access, ISO 9660 File Access, and High Sierra File Access 
Ales are present in the Extensions folder in the System Folder on your hard disk. If these 
fi les are not present, reinstall your CD-ROM software. The easiest way ro do this is by 
reinstalling )'Our system software. See Chapter 5, ·'Reinstalling Your Computer's Software.'· 

Problems Using Photo CDs 

Icon do esn't appear on desktop. 

• Reinstall the CD-ROM and Quicklime software. The easiest way to do this is by 
reinstalling your system softv.:are. See Chapter 5, "Reinstalling Your Computer's Software.'' 

Color icons for individual images don't appear. 

• Your computer may be low on memory. l b view color icons, restar1 your computer and then 
reopen the Phoros folder: See ivlac OS Help (choose Help from the Finder's Help menu). 
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Image is scrambled, colors are displayed incorrectly, or no image appears. 

• The program you are using may not be designed to work with large (high-resolution) 
image files. You can open the image with another program or you can assign more 
memory to the program. See Mac OS Help (choose Help from the Finder's Help menu). 

System ''freezes," or "bomb" message appears. 

• Restart your Macintosh. (If you need help restarting your computer, see Chapter 1.) The 
program you are using may not be designed to work with large (high-resolution) image 
files. You can open the image with another program or you 0 111 assign more memory to 
the current program. See Mac OS Help (choose Help from the Finder's Help menu). 

Problems Playing Audio CDs 

See ''Problems With Sound and Video," later in this chapter. 

Problems With Floppy Disks and Floppy Disk Drives 

Can't eject disk. 

If you can't. eject a floppy disk in the usual way, by selecting the disk's icon and choosing Put 
Away from the File menu or by dragging the disk's icon to the Trash, try the following in order: 

• Hold clown the :f€ and Shift keys and press the number 1 key on your keyboard. 

• Shut clown the computer. If the disk isn't ejected, then hold clown the buuon on your 
mouse or other pointing device while you start up the computer again. 

• Manually remove the elise, as described in "Disk Is j ammed," earlier in this section. 

If none of these solutions works, take the computer or disk drive to your Apple-authorized 
service provider to have the disk removed. 

Can't save or copy files. 

• The disk may be locked. Unlock it by sliding the tab at the corner of the disk so that it 
covers the hole. 

• The disk may be full. Throw away items on the disk that you no longer need, or save the 
files on a different disk. 

• The disk may be damaged. 'lest it with Disk First Aid, which is located on the system 
software CD. 

• The disk drive may be damaged. 1b see if this is the problem, try saving or copying files 
onto another floppy disk. If you are still unsuccessful, the drive may need professional 
repair. Contact your Apple-authorized service provider or call Apple for assistance. 



"This is not a Macintosh disk: Do you want to initialize it?" or "This disk is 
damaged: Do you want to initialize it?" message appears. 

• The floppy disk may be new and not yet initialized. If you're sure the disk has never been 
used, click Yes. 

Waming Clicking Yes erases all clara that may be on rhe disk. 

• The disk may have been formatted for use on DOS;'W'indows systems, or some other kind 
of com purer. If so, see the tips tim follow. 

• Click No in rhe dialog box asking you if you wanr w initialize the disk. 

• Make sure the PC Exchange control panel is in the Control Panels folder (in the Apple 
[ei] menu) and that iris [Urned on. Also, make sure PC Exchange is enabled in the 
Extensions Manager control panel. For more information about the Extensions 
Manager, see Mac OS Help (choose Help from the Finder's Help menu). 

• When formatting Aoppy disks on a DOS computer for use in a Macintosh, you need to 
format standard double-sided disks as 720K disks and high-density disks as 1440K 
disks. Double-sided disks formatted in 1440K format and high-density disks formatted 
in 720K format may nor work in a i'vlacintosh. 

If you think your DOS floppy disk might have a format that. doesn't work in a 
Macintosh, use a DOS computer to copy the contents of the disk onm a properly 
formaned disk. 

• The Aoppy disk may be too warm or too cold to be reacl. You can warm up a cold disk 
safely by setting it on top of your monitor for a few minutes. You can cool an overly warm 
disk by placing it in a shady, cool place. 

• The disk drive may be damaged. To see if this is rhe problem, click No to eject the disk; 
then insert the disk into another drive, if you have one. If you still see the message, the 
Aoppy disk may be damaged. If the disk icon appears on the desktop, one of rhe drives 
may be damaged. (When a disk that was wrinen on by one drive cannot be read by 
anorher, the heads on one of the drives are out of alignment. The drive that is misaligned 
or broken may not be the drive that cannot read the disk; try the disk in three or four 
drives w identify the drive with the problem.) 

• If none of these suggestions works, the floppy disk is probably damaged. First use a disk 
recovery program to copy the data from your damaged disk onto a good disk. For 
instructions, see the documentation that came with the disk recovery program. Then use 
Disk First Aid (located on rhe system software CD) w repair the damaged floppy disk. 
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Computer keeps asking you to reinsert disk. 

• An application program or document from the floppy disk is still open and is "looking for" 
the disk. Reinsert the disk and close the documents or quit the application programs that 
are open on the disk. (Go to lhe Application menu in lhe upper-right corner of your 
screen and make sure that the Finder is the only application listed. lf not, select one of 
the mher application programs and then choose Quit from the File menu. Do this for any 
other applications listed in the Applicalion menu.) Then eject the floppy disk by selecting 
irs icon and choosing Put Away from the File menu. 

Problems Printing 

The following suggestions should work for all printers. 

Note: Also refer to the manual that came with the printer. 

• Make sure that the printer driver for your printer is turned on in the Extensions Manager 
control panel in the Control Panels folder in the Apple (ti) menu. To find out the name of 
the printer driver-for example, Laser\¥friter-refer to the documentation that came with 
your printer. 

• Check your printer settings in the Chooser (in the Apple [ti] menu), making sure you 
have selected the correct printer. If you are using a printer that is shared by other 
computer users (a printer on a local network), make sure that AppleTalk (in the lower
right corner of the Chooser) is active. If you are using your own printer (a serial primer 
connected to your computer) and are not connected to an Ethernet network nor using 
Apple Remote Access, make sure that Apple1alk is inactive. 

• 'll.trn off the computer and printer and check the printer cable connections. 

• If none of these suggestions solves the problem, you may need to reinstall the ptinter 
driver that came with your printer. Refer to the manual that came with your printer. 

Important If you have an Apple printer, you need to determine which printer driver to 

reinstall-the one that came with your ptinter or one of the drivers included on your system 
software CD-ROM disc. Depending on when you bought your printer, one of these printer 
drivers will be more recent than the other. Reinstall the more recent one. 

Can't print, or error m essage appears. 

• There may not be enough memory for printing. Try the following: 

• Immediately after sending r.he Print command, quit the application you're printing 
from to free memory for printing. 

• Increase r.he amount of memory for the desktop printer icon; select it, choose Get Info 
from the File menu, and type a larger number in the Preferred Size box. 



• Reduce the amount of memory used by the application you're printing from. 

• If your document uses lotS of fontS, choose Page Setup from the File menu. :\•lake sure 
you have selected "Unlimited Downloadable Foms" under PostScript'N Options. If that 
doesn't work, use few·er fonts in the documem. 

• If the document coma ins complex graphics, remove some of the detail from the images. 

• Make sure the printer is turned on. Some printers need to warm up for a few minutes 
after you turn them on. 

• The printer may be out of paper or may need attention. Check the primer staws lights 
and any messages on your screen. 

• Open the desktOp printer icon and check for status messages. 

• Print a detailed report. (In the Prim dialog box, select "Print detailed report" under 
Error Handling.) 

• Reinstall your printer software. 

• Check the settings in the application's Page Sewp dialog box. lf there is a setting for 
"printer type," make sure it is set to the type of ptinter you are using. 

Performance and Other Problems 

Performance decreases. 

• If you notice a decrease in your computer's speed and general performance after you 
install a control panel or system extension, the sofn\•are may not be compatible either 
with Macintosh computers buil t with the PowerPC microprocessor or with other system 
extensions. See "Resolve S}'Stem Extension ConAicts" in Chapter 1. 

• Use the MemOty control panel to turn off virtual memory. See d1e information about 
memory in Mac OS Help (choose Help from the Finder's Help menu). 

Note: If you turn on both virtual memory and a RM1 disk in the Memory control panel, 
don't set both of them at or near their maximum values. Doing so can result in unpredictable 
or reduced performance by your computer. (A RAM disk uses random-access memory, or 
RAM, as if it were a hard disk.) 

• If you still do not notice an improvement, you may want to reinstall system software on 
your startup hard disk. See Chapter 5, "Reinstalling Your Computer's Software." 

• Jf }'OU typically use several application programs at the same time, your computer's 
performance will increase if you install more random-access memor)' (RAM) . See rhe 
setup manual that came with your computer. 
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Computer isn't performing well. 

If, after trying the rips in the previous section, your computer still isn't performing as fast as 
you'd like, try these suggestions. Each one will make only a small difference in your 
computer's speed, but if you try them all, you 'II nmice the improvement. 

• Open the Memory control panel in the Control Panels folder in the Apple (ti) menu; 
then make these changes: 

• In d1e Disk Cache section, increase the Cache Size slightly. (Because the amount of 
memory available for opening programs decreases as you increase the size of the 
cache, do not set the Cache Size roo high.) 

• In the Virtual i'vlemory section, cl ick Off if you haven't already done so. 

• Open the Keyboard control panel in the Control Panels folder; then make d1ese changes: 

• Set the Key Repeat Rate to Fast. 

• Set the Delay Until Repeat ro Shorr. 

• Turn off Menu Blinking. Open the General Controls control panel in the Control Panels 
folder; then click OfT in the Menu Blinking section. 

• If you don't need to sec thousands or millions of colors on the screen, reduce the color 
depth. Open the Monitors & Sound control panel in the Control Panels folder; then select 
256 in the Color Depth section. 

• Increase the speed of mouse tracking. Open the Mouse control panel in the Control 
Panels folder; then set Mouse lbtcking to Fast. 

• Make sure your computer is nm calculating folder sizes. Choose View Options in the View 
menu. Note: View Options is only available when "as List" is selected in the View menu. 

Make sure the checkbox ne\t to "Calculate folder sizes" is not selected. 

• If your computer is not connected to an Apple'Talk network, turn off Apple'Talk. Open the 
Chooser in the Apple (ti) menu; in the Apple'Talk section, select Inactive. 

3D rendering doesn't seem to be a ccelerated. 

The performance advantage of any 3D accelerator depends on the type of scene being rendered. 
Some applications may show the benefits of acceleration more than others. 

Not all computers are equipped with a 3D accelermor. If your computer came with a 3D 
accelerator, or you've installed one, check the following items: 

• Make sure tim your monitor resolution is set ro 640 x 480 in 16-bir mode (thousands of 
colors). Refer to the 7ecbnical fr!formation booklet for modes that support 3D accelerat:ion. 

• Make sure that your application uses QuickDraw 3D. Some older 3D applications don't 
use QuickDraw 3D for rendering, and cannot be accelerated. 



• If the Control Strip is overlapping or touching rhe 3D window, hide the Conu-ol Strip or 
move rhe window. 

• Some applications allow you to rurn hardware acceleration on or off. Check your 
application's documentation robe sure that hardware acceleration is turned on. 

• Check that rhe following files are in the Extensions folder, which is in the System f older: 

• AT! 3D Accelerator 

• ATI Graphics Accelerator 

• AT! Video Memory Ylanager 

• Turn off virtual memory. (Apple recommends turning off virtual memory whenever you 
use 30 applications.) Open the .Memoq• control panel, click the Off bunon in the Virtual 
i\'lemory section of the control panel, and restart your computer. 

Right-angle bracket prompt ( > ) appears. 

Your computer has tried to launch a "debugging" application (perhaps you inadvertently 
pressed the Command (:11:) and Power keys at the same rime), but could not find one on 
your hard disk. Debugging applications are programs that software developers use to locate 
and fix problems in computer code. If you do not have a debugging application installed, 
your screen displays a right-angle bracket prompt (>). 1b rerurn m the desktop or your 
application, t~·pe G and then press Return. 

Clock doesn't keep t ime accurately. 

If your clock begins to keep time inaccurately, have an Apple-authorized service provider 
replace the battery. Consult the service and support information that came with your 
computer for instructions on how to contact an Apple-authorized service provider or Apple 
for assistance. 

Warning Do nor attempt to replace rhe clock battery yourself. If the clock begins to 
lose accuracy, have an Apple-authorized service provider replace the battery. The service 
provider \\~ II dispose of the battery according to the local environmental guidelines. 

Icons look strange. 

• There may be a problem with the information that the computer uses to keep track of 
files. To fix this problem, rebuild the desktop. Hold down rhe Command (:IC) and Option 
keys on the keyboard \Yhile you restatt the computer. 

• You may be using a file-compression program to save space on your hard disk. Some 
compression programs change the appearance of icons. 

Font file can't be opened or m oved. 

• The fonr fi le may be damaged. Replace the fonr in the roms folder (inside the System Folder). 
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Blink ing icon appears in menu bar. 

• A program needs attenrion. Open the menu and choose the program whose icon is 
blinking (it may have a diamond by its name). Respond w any messages on the screen. l f 
it's nm clear what you should do, consult the documentation that came with the program. 

• Open the Easy Access control panel (if it is installed on your computer) and check 
whether any of its features arc turned on. 

Computer makes unusual sounds. 

• Select a different system sound in the Sound comrol panel. 

• If the sounds are regular or melodic, they may be caused by imerference from electrical 
equipment. Move the computer farther awt~y from any such equipment. 

Problems With Networks and File Sharing 

If you are having problems using the network or file sharing, try the following before 
attempting further solutions: 

• Make sure the network is working by opening the Chooser and checking for the shared 
disks and primers you usually use. See if other computers on your network have access ro 
network devices. 

• Make sure that Apple'lalk is turned on in the Chooser. 

• Open the AppleTalk ~mel TCP/IP control panels and make sure the settings are correct. See 
the topic on file sharing in Mac OS Help (choose Help from the Finder's Help menu). 

• Make sure tim all the network software is insta lled. The Network and AppleShare 
extensions should be in the Extensions folder. If you want to use file sharing, the File 
Sharing control panel should be in the Comrol Panels folder, and the File Sharing 
Extension shou ld be in the Extensions folder. If any of these items is missing, reinstall the 
system software. See Chapter 5, '·Reinstalling Your Computer's Software." 

• Check that you are using the correct driver software for any networking card installed in 
your computer. Also check with the networking card manufacturer to make sure you are 
using compatible hubs and routers. 

• There may be a physical problem with a cable, connccwr, bub, or wall jack. Make sure 
network cables are connected properly. If )'OU use an expansion card to connect to 

Ethernet, check rhat the card is installed correctly. 'll·y substituting equipment rhar you 
know is reliable. (You can even try a different computer if one is available.) 



Computer you want doesn't appear in the Chooser. 

• Make sure the computer you're trying to connect to is turned on. 

• Make sure file sharing is active on rhe computer you're trying ro connect ro. (That 
computer's File Sharing control panel should say that file sharing is on.) 

Shared disk you want to use is not available. 

• You may already be connected to the shared disk. Check for its icon on your deskrop. 

• You may not have rhe access privileges you need to use the shared disk. Ask the network 
administrator or the owner of the shared item to give you access. See the information on 
file sharing in Mac OS Help (choose Help from the Finder's Help menu). 

Can't see any files on remote computer. 

• Make sure that files are being shared on rhe other computer. The File Sharing Monitor 
control panel on that computer lisrs the items being shared. 

• Make sure you have the access privileges you need to view the files. Ask the network 
administrator or the owner of the shared item to give you access. See the information on 
file sharing in Mac OS Help (choose Help from the Finder's Help menu). 

File sharing can't be turned on. 

• Make sure AppleTalk is turned on in the Chooser. 

• Make sure you have at least 400K of space avai lable on your hard disk. 

• Some rusk-formatting programs don't work with file sharing. If you use such a program, 
contact the manufacturer or vendor for compatibility information. 

• There may be a problem with some of the information your computer uses to start up file 
sharing. Follow these steps in order until the problem is solved: 

1 Open the File Sharing control panel and enter new information in the Network 
Identity section. Then try again to turn on file sharing. 

2 Remove the File Sharing folder from the Preferences folder (inside the Sysrem Folder). 
Then restart the computer and try ro turn on file sharing. 

3 Reser the PRAM by following the instructions in "Reset the PRAM" in Chapter 1. 

4 Remove the Users & Groups Data File from the Preferences folder (inside the System 
Folder). Restart the computer. 

5 Reinstall system software. See Chapter 5, "Reinstalling Your Computer 's Software." 

• Server: If you are using AppleShare IP, make sure the File Server is on. 
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Item can't be shared. 

• Make sure you have at least 1 MB of space available on rour hard disk. 

• Some removable storage devices can't be shared. Check with the manufacturer or vendor 
of the device for more information. 

• Some disk-formatting programs don't work with Ale shating. If you use such a program, 
check with the program's manufacturer or vendor. 

Can't open a shared disk or folder. 

• You may not have the access privlleges needed to use the disk or folder. Ask the network 
administrator or the owner of the shared item to give you access. 

• Check with the owner of the item to make sure you are entering your name exact!)' as the 
owner specified (including spaces and capitalization) and try again. 

You can't remember your Administration password. 

• Erase your Administration password (along with all of your Applel11lk settings and 
configurations) by dragging the AppleTalk or TCP/IP Preferences file (inside the 
Preferences folder in your active S)'Stem Folder) to the Trash. When you open the 
Apple'lafk or TCP/IP control panel again, you must reenter all your settings. 

Your computer can't connect to devices outside its local network. 

• Check that your router address is correct. 

Your computer can connect to hosts by IP address, but not by name. 

• Check that you have entered valid domain names in the Additional Search Domains box. 

• If you have entered your local and administrative domain names, double-check to make 
sure they're correct. 

• Check that the domain name server (DNS) you have selected is actually a DNS server and 
is operating properly. 

Servers: Your computer does not respond to a "ping.'' 

• Check that you have an application open on your computer that uses TCP/IP and can 
respond to a ping from another computer, and that the correct port is being pinged. 

• Check that your TCP/lP configuration is correct. 

• Check that the Use 802.3 checkbox isn't selected in the TCP;TP control panel. 



Problems With Sound and Video 

Can't hear any sound. 

• If you have headphones or speakers connected to the com purer, make sure they are 
11rmly connected. Make sure the volume conrrol on you r headphones or speakers is not 
turned down roo low. 

• If you do not have headphones or speakers connected to the computer, make sure that 
norhing else is plugged into the computer 's sound output pon (~>l)). 

• If you are using a CO-ROM disc over a network, you \von't be able to hear the audio portion. 

• Make sure that the correct sound source is selected in the Monitors & Sound control 
panel or in the SoundSource module in the Control Strip. 

• ~·lake sure the volume is turned up in the AppleCO Audio Player. With the program open, 
drag the volume control slider up, use the volume controls on your computer, or press 
the Up Arrow key on y·our keyboard. 

• The CD may have been paused. Click the Play/Pause button in rhe AppleCD Audio Player. 

• If your CD-ROM drive was installed after you bought your com purer, make sure the audio 
cable is properly connected. See the documentation that came with the CD-ROM drive. 

Audio stops playing when you double-click a CD-ROM disc icon. 

• You can't open data files on a CO-ROM elise and listen to audio tracks on it at the same rime. 

Audio CD begins playing automatica lly when inserted. 

• Your computer is set to automatically begin playing audio COs when they are insened. To 
turn off this feature, use the Quick Time Settings control panel to change the au tomatic 
play setting. 

Sound comes out of computer even though headphones are plugged into 
monitor. 

• Plug your headphones into the headphone jack (0 ) on the front of the computer. 

• If your computer has a subwoofer and you want to keep the headphones connected to 
the monitor, manually turn clown the subwoofer. Turn the knob in the subwoofer balance 
comrol pon (.....,..) coumerclockwise to turn off rhe subwoofer volume. Remember to turn 
ir back up the next time you want to hear the subwoofer. 

Sound in headphones is odd. 

Some computers have sRs(eJ 30 Surround Sound, which doesn't work well through 
headphones. To turn it off, open the Monirors & Sound control panel and click the Sound 
icon. Click ro remove the X from t.he "Enabled" checkbox. 
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Subwoofer balance control(....,..) doesn't work. 

For computers with a subwoofer, the balance conrrol affects the subwoofer volume only 
when the computer has exwrnal speakers attached or the monitor has built-in speakers. 
Otherwise, the subwoofer balance control (....,..) has no effect on your computer's overall 
volume. Adjust your computer's volume with the sound controls on the from of the 
computer or monitor, with the volume control sliders in the Monitors & Sound control 
panel, or with the volume controls in the AppleCD Audio Player (if you're listening to an 
audio CD). 

Can't record from audio CD. 

• Check your computer's sound input port to see if a microphone or other device is connected. 

• You may need to reset the sound options in the \•lonitors & Sound control panel. See the 
information on sound in Mac OS Help (choose Help from the Finder's Help menu). 

Can't record with microphone. 

• Make sure your sound input source is set to "External Microphone." Open the Monitors & 
Sound control panel, click the Sound icon, and choose "External Microphone" from the 
Souncllnput pop-up menu. 

• If you're using your monitor's built-in microphone to record, use the Monitors & Sound 
control panel to mute the monitor's speakers. In the same control panel, make sure that 
the sound input is set to the monitor's built-in microphone. 

See the information abom sound in Mac OS Help (choose Help from the Finder's Help menu). 

"QuickDraw 3D could not be found" message appears. 

• Make sure that the following flles are in the Extensions folder (inside the System Folder): 

• QuickDraw 3D 

• QuickDraw 3D RAVE 

• QuickDraw 3D Viewer 

• QuickDraw 3D JR 

If the files are there and you still get the message, it means that you don't have enough 
memory to run the application. You may be able to open the application if you try one or 
more of the following: 

• Quit other open applictHions. 

• Reduce the amoum of memory allocated to the application. Follow these steps: 

1 Select the application's icon in the Finder. 

2 Choose Get Info from the File menu. 

3 l ype a lower number in the box for Preferred Size. 

• Install more memory (Rfuv!) . 
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Starting Up From a CD or Floppy Disk 
To test, repair, or initialize a hard disk, or to install or remove system software on a hard disk, 
you need to start up your computer from another disk. You can start up your computer using 
the system software CD-ROM elise, or (if your computer does not have a CD-ROM drive) 
from the Disk Joo/s disk or a floppy disk conraining system software. 

Starting Up From the System Software CD 

Follow these steps to start up from the CD containing system sofrware. 

1 Turn on your computer if it's not ~t l re"cly running. 

2 Press rhe Open/Close button of your CD-ROM drive ro open the tray. 

3 Place the CD containing system software in the tray with the disc label facing up. 

Make sure the disc is lying ftat in the tray. 

4 Close the u·ay by pushing rhe rray in or pressing the Open/Close butron. 

5 Hold down the C key on your keyboard while you choose Restart from the Special menu and 
wait for the message "Welcome to Mac OS" to appear. 

If this doesn't work, restart the computer, make sure the CD is insened, and hold clown the 
Command, Option, Shift, and Delere keys (to temporarily disable the hard disk). Hold the 
keys clown unril the message "Welcome to Mac OS" appears. 

6 When you see the screen that says "Mac OS" and the phrase "Starting Up," release the C key. 

In a few seconds the desktop appears. Since your computer is nmv running rhe system 
software rhat's on the CD, the desktop pattern is clifferem from the pattern you normally 
see. The CO's icon appears at the top-right corner of rhe cleskrop (above your hard disk 
icon), and the Apple (tl) menu does nor comain the usual items. 
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When You're Done With the CD 

When you start up your computer from a CD, the CD cannot be ejected in the usual wa)'· 

lb restart your compmer from the hard disk and eject rhe CD: 

1 Choose Restart from the Special menu. 

2 Immediately after hearing the starrup chime, press the eject button on the front of the CD dti ve. 

Note: You can also change the startup disk by opening the Startup Disk control panel and 
selecting rhe hard disk. Restart your computer. After stanup, eject the CD by selecting its 
icon and choosing Put A war from the File menu (or by dragging its icon ro the Trash). 

Starting Up From a Floppy Disk 

If your computer does not have a CD-ROM drive, you need to start up with a floppy disk 
containing srstem software in order to test and repair your hard disk or install system 
software. See the setup manual that came with your computer for information about 
obtaining system software floppy disks. 

Follow these steps to start up from a floppy disk containing system software. 

1 'fiJrn on your computer. 

2 Insert the floppy disk containing system software. 

If you are testing, repairing, or inilializing a hard disk, insetl the Disk Tools disk. If you are 
installing system software, insert the first disk of d1e system software disk set. 
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Testing and Repairing Your Hard Disk 
If you see a message reponing that a disk is "damaged" or unreadable, data on your hard disk 
may have become corrupted. 

Data Can Be Corru ted 

• any time the computer is not shut clown properly, using the Shut Down command 

• when your computer freezes or crashes 

• if SCSI devices are not properly connected and terminated 

Repairing Corrupted Data on Your Disk 

Most data corruprjon can be fixed easily by using Disk Fim Aid. Disk First Aid is on the 
system software CD that came with your computec 

1 Stan up your computer from the system software CD or the Disk Tools disk. 

See Chapter 3, "Starring Up From a CD or Floppy Disk." 

2 Locate the Disk First Aiel icon and double-click it to open the Disk First Aiel program. 

Disk First Aid 
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3 Click the icon of che disk you wam co rest. 

Disk icons appear in a box at the mp of the Disk Firsc Aid window. 

:: :::-""' ~DISk First Aid -- --- -- EJ 
S.ltct vokltnH to vwlfL,J : tbnbtr of "okm.s st\K:t~: I - II mmm AWlt MIClntosh CO 

SCSIIO 0 (vii 0 B) CO· ROM SCSIIO 3 (a) 
(Si td up Disk) (',it'ltt Proltctt<O 

• • 
Rt vitw Instructions .and rtsult s: 
Disk Ftrst Atd : . 

II Vertty_ !I Du k first Awt k ~ uhllt\1 'ffhkh vtl'if\ts tht dlrtot~ s truoturt of·~ 
Hitn rcMal rtlt 54,! stem (HFS) ban d s1cr .. gt velum.. Mliny h&rd disk Q-fvts , 

I ll~pair I f1opp4,1 disk and CW()ttt Oisk (CD) drlvts &r• t )(.¥nplts of HFS-butd s toragt 
vokmts. 

I Stop I If Ynptrltc:tklns _... found vitnln a volvmf. Dtsk rrs t Aid c.«"~ bf used n • 
.. fil"'st s ttp'" to rtp&fr tht dtftcts. If 1 voiYmt las sufftnd stvtrt oorrt4)Uon 
other ulillly pro; r .. ms or rt~ir" methods m11,1 ntrd to bt ustd 

Running Dis k Firs t Aid : 

Chdc on \ht volumt you vould llkt to vtrif\1 or n p•r. MJH~lf volvmts <:In 
bf. n ltott d bl.l holdln9 down lht Shift kty .,.,hllt oliokhg on ttt. volumts. . 

4 Click Repair to begin testing and repairing the disk. 

If Disk First Aid Cannot Correct the Problem 

• Make sure you started up from the CD-ROM elise or floppy disk. See Chapter 3, "Starring 
Up From a CD or Floppy Disk." 

• Try running Disk First Aiel a second or third time. Sometimes repeating che process 
corrects the problem. 

• Use the Drive Secup utility m update che drive~: 

• Use another disk repair or recovery program, such as Disk Doctor from N011on Utilities. 
Sometimes another program will help you recover a corrupted disk. 

• If you can't repair che disk, the System suitcase file or other resources may be damaged. 
Perform a clean inscallacion of system software (see Chapter 5). If chac doesn't work, 
reinitialize the hard disk as desoibecl in the following section. 

Initializing a Hard Disk 
The hard disk inside your computer was initialized (formatted for use) at the factory, so you 
should need to initialize it only if your hard disk is damaged and can't be repaired with Disk 
First Aid (or another disk repair program). 

You can initialize your internal hard disk using a program called Drive Sewp, which is on the 
system software CO-ROM disc that came with your computer. 



Note: If your hard disk is not an Apple hard disk, use the disk utility sofC'Ivare provided by 
the disk's manufacturer instead of Drive Setup. 

Warning Initializing a disk erases all information on the disk. Before initializing your 
disk, recover all the information you can and copy it to another disk. 

1 Start up your computer from the system software CD. (See Chapter 3, "Starting Up From a 
CD or Floppy Disk.") 

2 Locate the Drive Setup icon and double-click it to open the Drive Setup program. 

DrivE- Seotup 

3 In the list of drives, select the disk you want to initialize. 

I:;;---= - orlveSetup """ -=.-r- ; 13 

UstofDrives 

Volume ftame(s) 
Htr'd Oi s:k 
(CO-ROM drl\.,., 

I s. ... , • ddvt "'" ,...., , r .... uon. 

4 Click Initialize. 

Ty,. Bus 10 LUH 
SCSI 0 0 0 .,. 
SCSI 0 3 0 

---
( lnltl.lioJ~ .. 

If initialization fails, choose Initialization Options from the Functions menu to sele([ the "Low 
level format" and "Zero all clara" options. Then t!")' initializing the disk again. 

If initialization fails a second time, test your hard disk for damage, as described in "'Jesting 
Your Hard Disk for Physical Damage" at the end of this chapter. 

Mac OS Extended Format 

Mac OS Extended format is a new method of formatting hard disks that allows for more 
efficient use of hard disk storage space. You can format your hard disk with .Mac OS Extended 
format by performing a custom initialization of your hard disk. For instructions, see Drive 
Setup Help in the Help menu. 

Important Mac OS Extended format requires Mac OS 8.1. Computers running earlier 
versions of system software cannot access fi les on a Mac OS Extended disk. 
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Testing Your Hard Disk for Physical Damage 

Note: "Iesring the disk can take two hours or more, depending on the size of your disk. 

1 Stan up your computer from the system software CD. (See Chapter 3, "Starring Up From a 
CD or Floppy Disk.") 

2 Locate the Drive Setup icon and double-cl ick it to open the Drive Setup program. 

Drive S€'tup 

3 In the list of drives, click the disk you want to rest. 

~ ·- Drive Setup-- ·- 13 

Ust of Dr ives 

Hard Disk 
<CO·ROf1 dr lve) 

Tv,. Dus ID wn 
SCS I 0 0 0 -
SCS I 0 3 0 

r iniU<lhlt! ... 

4 From the Functions menu, choose Test Disk. 

5 When a message tells you that the resting is complete, click Quit. 

If the rest reveals a problem, the hard disk is probably damaged. Consult an Apple-authorized 
service provider for assistance. (If you have a hard disk from another manufacturer, consult 
that manufacwrer for assistance.) 



C H A P 

Reinstalling Your Computers Software 
Your Macintosh came with all the necessary system software installed on its internal hard 
disk. You need ro install system software on your internal hard disk only if 

• you wam ro restore your system to its original factory settings 

• you encounter software problems and need to reinstall system software 

• you want to add or remove system software componenr:..'i 

• you have a new hard disk 

Restoring Custom Settings and Bundled Software 

Your computer may have come from the factory with the following: 

• additional applications such as Claris\X1orks® 

• customized system software settings such as System Folder protection 

• the Mac OS Info Center 

When you reinstall system software using the Mac OS 8.1 Installer described in this chapter, it 
may nor reinsrall additional applications, reset customized settings, or reinstall the 
information in the Info Center. 

If ~'our computer came with extra application software, see the Read Me document on the 
system software CD or floppy disks for instructions on how to restore that software. 

Before Installing System Software 

Before you begin the installation, do the following: 

• Virus-protection and disk-securi~y sojiware: Turn it off. 

• At Ease sojtu.Jal-e: Turn it off. For instructions, see the At Ease user's manual. 
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• PowerBooks: Plug your Power Book in and set it so it doesn't go w sleep. Turn off 
password protection in the Password Security comrol panel. 

Important It is highly recommended that you back up the data on your hard disk before 
installing system software. 

Reinstalling Mac OS System Software 
Note: If something goes wrong, see "Problems Outing installation" later in this chapter. 

1 Stan up from the system softwtl re CD-ROM elise (or floppy disk). 

For instructions, see "Starting Up l'rom a CD or l'loppy Disk," earlier in this handbook. 

2 Double-click the Install Mac OS 8.1 alias. 

~ 
lMtell the 05 8. / 

Note: ff you are installing from a floppy disk, the Installer may open tlutomatically. 

A welcome screen describes the steps in the installation process. 'lo let1rn more abom each 
step, click the Help button (l'1.l) in the upper-right corner of rhe window. 

0 = Install Mac OS 0 = " 1!1 

X Welcome m-
Welcome to the Mac OS 0 Installation program. This program wil l 
guide you through the four steps necessary to lnstnll Mac OS 8. 

J. Select a destination disk 

2. Read lm110rtant Information 

3. Respond to U1e softwar e license agreement 

4. Install softwar e 

Click Continue to begin the l lrst sl ap 
--

- II COntinue l) G<1 !lilt~ 

f-Click to display 
more informal ion 
about eacb step. 



3 When you're ready m begin, click Continue. 

The Select Destination dialog box appears. 

[] ·- ---::- -':'il lnstaiiMacOSO~ ~ --::= 13 

f ' SelectOestlnfttion [iJ 

Choose a disk to Install the software on, t hen click Select. 

Oestln~tlon Dlslc: J Mnclntosh HD I ~) 
Sl,ls lt m so fht..,,.~ eurrtntly fns tflltd: 9.0 

Av,flabW disk sp•c. : 127 I"'S 

Approxim.ttt disk Sp..Klf rtqUirtd fer buk inshii&Hon: 95MB 

0 Perform Clean lnst~ il atlon 

I Go Back I fl _ Select Q 
1 

If you want to perform a clean installation, skip to "Performing a Clean Installation," later in 
this chapter. Otherwise, continue with the following step. 

4 Choose the destination disk from the pop-up menu and click Select. 

The following dialog box appears. 

ff:l 
~ 

The selected destination disk already has 
Mac OS Blnstalled. Do you want to: 

• Reinstall Mac OS 0 
• Add or remove software features 

I Cancel I I R~lnstall I ij Add/Remove n 

5 Proceed to the next section, "Selecting Which Software to Install." 

Selecting Which Software to Install 

After selecting a disk, you need to decide between a standard or a custom installation. The 
standard installation installs all the software you need for your model of compmer and is the 
best choice to solve system software problems. A custom installation lets you add or remove 
specific system software components. 

Note: Keep in mind that the more componems you install, the more RAM is used and the 
greater the poremial for software conflicts. Install only the items you expect ro use. 

Standard installation: Click Reinstall. Proceed to "Standard Installation," next. 

Custom installatirm: Click Acid/Remove. Proceed to "Custom lnstallation," later in this chapter. 
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Standard Installation 

1 Follow the instructions on your screen until you see the Install Software window. 

0 ~ ·-- --- Install Mac OS 0 -- ~ 8 

~ Insta ll Software fil 
Olck Stllrtto Install the Mnc OS B bnslc system nnd any selected softwMe on 
"Mnclntosll llD." 

OpUon•l soft-..•r• lnsto~l~tlon ~t.tus 

Iii Mac OS Runtime for Java 'w'i11Wtns.tlln.d 

~ 1iJ Personal Web Sharing Vill bt lns,h lltd 

Iii Open Doc 'Will btlnshlltd 

Iii MacUnk Plus " lll bt il\stalltd 

0 Apple Location Manager ' 'fll not bt W!st111td: 

0 Cyberdog Willoot botfost.alk>d 

0 QulckDraw GX wmnot~inst.alltd . 
I Customjze l I O~tlons ... l I Go Back I (I Start ~ 

Note: Your screen may look slightly different from the one pictured here. If you're installing 
from Aoppy disks, you won't see all the choices that are available from the CD-ROM disc. 

2 Select the software to install along with Mac OS 8.1. 

Mac OS 8.1 will be installed automatically. Select or deselect orher items you want to install. 
Boxes that are checked are normally installed as part of the Mac OS. 

3 Click Start. 

4 \Xn1en the installation has finished, restart your computer. 

Build-to-order computers: You may need to install additional software for your 
computer's custom components. See the documentation that came with your computer. 



Custom Installation 

0 ;;: ·-= --- -:..:-· Install Mnc os 8 - --··---c- - 8 

$; Custom Installation nnd Removal [1] 

Click Start to launch selected software Installers. 

Soft-.r.lrf' Yl'"h ntrs: ~st.1llw stJtus 

0 Mac OS 0 Viii no t bto lt unch•d 

~ D Mac OS Info Center vm no t bt ltunehtd 

D Internet Access \/ill not bt ltt.ncht d 

D Open TransrJort PPP Vlll not btl~eh~ 

D Mac OS Runtime for Jnv.1 W11l not bt l.wnchtd 

D Personal Web Sharing wmnot ~ l.li'Jnchf.d 

D QuickDraw 3D 'rifllnotbt~hf.d y 

I Don"t Customize I I Options • . I I Go Back I ([_ St.trt 1) 

Note: Your screen may look slightly different from the one pictured here. If you're installing 
from floppy disks, you won't see all the choices avai lable on the CD. 

1 SeleC[ the software to install, the sofrware to remove, or both. 

You can choose whether or not to install Mac OS 8. If you select Mac OS 8, you can acid or 
remove specific components ofiV!ac OS 8. 

Note: As you proceed, you'll be able w determine exactly which components will be 
installed or removed for the software you select. 

2 Click Start. 

If you see messages about problems with your hard disk, see "Problems During Installation," 
at the end of this chapter. 

Installers for each of the components you selected wi ll appear. For most of the components, 
you just need to click the Install button. If you chose to install Mac OS 8 software, continue 
\Vith the following steps. 

3 When you see the Mac OS 8 Installer's welcome screen, click Continue. 

lf you want all the recommended components, click Insrall. Then follow the onscreen 
instructions (skip the remaining steps in this section). 

If you \Vant to install or remove specific components, follow steps 4-7. 
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4 Open the pop-up menu and choose an item. 

• If you wam tO install software, choose Custom Install. 

• If you want to remove software, choose Cusrom Remove. 

Easy lnstnll 

Custom Remove 

All available components for the soft>vare product appear in the Installer's window. 

~ ~ =~ Install System Software ~ 
- -.ar- ·'--'09 

I Custom Install 
Chtdc (uturu to b• tnshlltd 

• I I Options._ I I Help I 
0 Universa l Sys tem for any suptJorted comtJuter CD • 
0 System Software rorthls com1111ter rn~ 
0 Core System Software rn 

-----------------------------------------
1> 0 Assistance rn 
1> 0 Compatibility (!) 

1> 0 Mobility rn 
1> 0 Multim edia 11),.. 

Dlsksp.c•av•O•blf: 1 0!5,1~3K Stlto1td s lu : uro K 
,-OestinaUon Disk 

I Eject~! I Quit I 
c:::::J I Swattll 01\k I Har·d Orin [!-II! ill' tns ttlll ] 

~ 

5 Scroll through the list of components and click the checkbox next to each componenr you 
want ro install or remove. 

You can see and select individual items within each component by clicking the arrow to the 
left of the component, then cl icking the item you want to install. For more information about 
each component listed, cl ick the box with the letter i in it to the right of the componenr. 

6 Click Install or Hemove. 

The selected items will be installed on or removed from your computer. 

If you have problems while installing, see ·'Problems During Installation," at the end of 
this chapter. 

7 Hepeat steps 4-6 for a lithe software you selected. 

After you finish installing or removing a software product, the Installer for the next product 
you selected opens automatically. 

8 When the installation has finished, restart your computer. 

Build-to-order computers: You may need to install additional software for your 
computer's custom components. See the documentation that came with your computer. 



Performing a Clean Installation 

This section provides instructions for what is commonly called a clean insta!fation of system 
software. Performing a clean installation is more complicated than a standard installation, but 
it is sometimes the best way to solve a persistem problem. A clean installation gives you a 
fresh st<ut with system sohware. 

When you instll ll system software using a clean installation , the Installer creates a new System 
Folder on your hard disk. The old System Folder is renamed Previous System Folder. Since 
your computer has a new System Folder, after a clean installation you must reinstall custom 
fonts, extensions, and control panels that you've added to your system or that came with 
utility or application programs. 

Note: Though applicmion programs are not replaced or changed, some require system 
software componenrs that are removed from the System Folder during a clean installation. 
You may need to reinstall these applications after you perform a clean installation. 

1 Start up your computer from the system software CD-ROM elise (or fioppy disk), as described 
in Chapter 3, "Staning Up From a CD or Floppy Disk." 

2 Open the Mac OS Installer application. 

3 In the Welcome box, click Continue. 

The Select Destination dialog box appears. 

0 ~---...,.=-- -- - l nstll ll Mn( OS 0 '' -~- ~ -- -- -~-:.13 

f& Select Destination [1] 

010ose a disk to Insta ll the sonwnre on, then click Sel ect. 

Destination Disk: J Mn, lntosh HD ;I 
~st'Jrn son.,.,..,.., currtntll.l VlJt.alltd : 8 0 

Avafbblt disk~· · 127MB 

Approxlrnat t difk spao. rt<p.~Ytd for basic lnst <~~ llaticn . 9St1l 

frMs db:'c n.s ·~ ,~-;-for • b.sic inst .. n.aHon. --- -

0 Perform Cl enn Installation 

I Go !lack l (I Select ~ 

4 Click the Perform Clean InstallaLiun checkbox so that it has a checkmark in it. 

5 Click Select and follow the instructions until you see the Install Software dialog box. 

6 Select the software products you want to install. 

7 Click Stan to install the software you've selected. 

A new System Folder is installed on your hard disk. (The old System Folder is renamed 
Previous System Folder.) 
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8 Restart your computer from rJ1e hard disk. 

If tbe problem is solved: See the following section rJ1at describes how to reinstall your 
custom extensions, fonts, and control panels. 

(/'!be problem is not sol/Jed: You can reinsmll your custom extensions, fonts, and control panels; 
or you can restore the previous system. These options are described in the following sections. 

ReinstaJUng Your Custom Extensions, Fonts, and Control Panels 

After a clean installation, you need to reinstall any custom extensions, foms, and control 
panels you were using. If you don't have the original installation disks, you can drag items 
one at a time from the Previous System Polder ro the new System Folder. It's a good idea to 
restart your computer after you install each item, to see if that's the item causing the 
problem. After you're sure rJm you've copied all rJ1e items you wam imo the new System 
Folder, delete the Previous System Folder by dragging it to the 'll'ash. 

Build-to-order computers: You may need to install additional software for your 
computer's custom components. See the documentation that came with your computer. 

If the Clean Installation Didn't Solve the Problem 

You may have a hardware problem. Consult an Apple-authorized service provider. 

You may want to revert to the Previous System Folder so that you do not have to reinstall 
your cuswm extensions, fonts, control p;mels, and other items not installed with Mac OS 8. 
'Ib use the previous system again, follow the steps in this section. 

Warning This procedure may not work. If it does not, you will have to perform a 
clean installation again. 

1 Locate the curremly active System Folder. It is distinguished by the Mac OS icon on it. 

2 Open d1e System Folder and move the System suitcase into the Preferences folder. Close the 
System Folder. 

3 Rename the System Folder "Clean System Folder." 

4 Hename the Previous System Folder (the one you wish to use again) "System Folder." 

5 Open the newly designated System Folder and double-click the System suitcase. Close the 
window that appears, then close the System Folder. 

The Mac OS icon should appear on the new System Folder's icon. 

6 Res tan your computer. 

7 Drag the Clean System Folder to the Trash. 



Problems During Installation 

This section helps you solve problems you may encounter while installing your software. 

You can't start up the computer using the system software CD-ROM disc or 
floppy disk. 

• Your computer may have located the system software on your hard disk before it located 
the system software on the CD or iloppy disk. If }'OU have an external hard drive with 
system software, the computer may start up from that device instead of the CD-ROM disc. 

With the CD or floppy disk inserred, open the Starrup Disk control panel and click the CD 
or floppy disk icon. Then restart the computer. 

Note: After you install the software, you'll need to reselect your hard disk as the startup 
disk. Open the Startup Disk control panel again and click the icon for your hard disk. 
Then restart you r computer. 

The files on your hard disk disappear when you start up from the CD-ROM disc. 

• Your hard disk may have been formatted with Mac OS Extended format. (Mac OS 
Extended format is a new method of formatting hard disks that allows for more efficient 
use of hard disk storage space.) Start up your computer using a hard disk or system 
software CD that contains Mac OS 8.1 (or later). Earlier versions of the system soft,vare 
cannot recognize Mac OS Extended format disks. 

The Installer cannot repair your hard disk. 

• If you see a message that the disk can't be fiXed because a file is open, quit all programs. If 
file sharing is on, turn it off. Then try installing again. 

• Use Disk First Aiel or a third-pany disk repair utility to see if it can repair the disk. 

If you don't have a third-party utility, or if that utility can't repair the disk either, you may 
need ro reinitialize the hard disk. See "Initializing a Hard Disk," in Chapter 4. After you've 
reinitializecl the disk, try installing the system software again. 

The Installer cannot update the hard disk driver. 

• lf you don't have an Apple-brand hard disk, or if you've updated your Apple hard disk 
with a non-Apple disk utility, use that disk utility or the one supplied by the disk's 
manufacturer to update the drivers on your system. Make sure to get the latest version of 
the utility. 

• Some hard disks must be reinitialized before you can update the driver. See Chapter 4 for 
instructions on initializing your hard disk. 

You see a message that there's not enough memory to use the Installer. 

• i\·Iake sure you are starting up the computer from the system software CD-ROM el ise or 
floppy disk. 
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You see a message that the System file cannot be modified. 

• You may have virus-prmection softw~ re installed that guards against modification of the 
System file. Make sure you are starting up the computer from the system software 
CD-ROM disc or Aoppy disk. Drag any virus-protection software out of the System Folder 
and try installing again. You can put the virus-protection software back after installation. 

• The System and Finder files may be locked. lb see if your System file or Finder Ale is locked, 
open the System Folder and select the System or Finder icon. Open the File menu and 
choose Get Info. To unlock the me, click the Locked checkbox to remove the checkmark. 

• Try performing a clean installation of system software as described earlier in this chapter. 

You see a message that the installation was not successful. 

• Make sure the system software CD (or Aoppy disk) is the startup disk, then try installing 
system software again. If d1e installation is still not successful, u·>' performing a dean installation. 

Responding to Messages About Your Hard Disk 

The Mac OS 8 Installer checks the destination hard disk for errors before installing the 
software. Additionally, if >'Our hard disk was formatted with an Apple disk utility program, the 
Installer updates the hard disk drivers wid1 d1e latest version of the driver software. If your 
disk drives are formatted wid1 a disk utili ty from another company, the drivers are not updated. 
You should use the third-party disk utility ro update your hard disk before installing Mac OS 8. 



CHAP R 

Contacting Apple for Help 
If tJ1is handbook has not helped you solve your computer's problem, contact Apple for 
assistance. For information on how to contact the Apple Assistance Center, see the service 
and support card that came with your computer. 

Have This Information Available Before Calling 

Have the following information and software available when calling the Apple Assistance Center: 

• what you have tried to do already 

• a description of the problem (for example, the computer freezes in only one application 
or at srarLUp) 

• the type of computer, serial number, version of system software, third-party software, 
external devices, internal devices, and so on (especially if the problem involves something 
you have added to the computer) 

• the system software CD, Disk Tools disk, or stanup disk 

Be in from of the computer when you call so you can take steps the technician suggests. 

Using the Apple System Profiler 

If you are able to stan up your computer, the Apple System Profiler provides information 
about your computer that will help you and the Apple Assistance Center troubleshoot your 
computer. 

lb open the Apple System Pro filer: 

• Choose Apple System Profiler from the Apple (tl) menu. 

When you open Apple System Profiler, a System Overview window appears. Use the 
commands in the Select menu to get more specific information about the hardware and 
software used by your computer, or tO go back to the System Overview window. 
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To find out what the items in the Apple System Profiler window mean, choose 
Show Balloons from the Help menu. Then point to the item you want to know about. 

The Create Repon command in the File menu lets you create a customized repon of 
system software information. You can print this repon by choosing the Print command from 
the File menu. 
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testing hard disk 46 
30 accelerator 34-35 
30 Surround Sound 39 
troubleshooting. See also specific problems 

Apple Assistance Center and 57 
Apple System Profller and 57-58 
application programs 19-25 
external equipment 8-9 
frozen system 2-3, 6, 20, 30 
jammed disks 26 
keyboard 3, 9 
Mac OS Help and 18 
Mac OS Info Center and 18 
monitor 8, 34 
mouse 3,9 
printing problems 9, 32-33 
problems during system software 

installation 55--56 
problems using computer 19-40 
reinstaiJing system software and 17, 47-56 
startup problems 1-17, 55 
unusual sound when starting up computer 1 

turning off computer 7, 8 



u 
unlocking files 24, 56 
unlocking floppy disks 22, 24, 30 

v 
virtual memory 10, 20, 33, 35 
virus-protection software 21, 47, 56 

W,X,Y,Z 

"waking up" computer 6 
Web sites, Apple 18 
"Where have all my files gone" document 26 
windows 

disappearing 25 
no icons appear in 4 
resetting window display 11 

Windows documents 24,31 
Zip disks, jammed 25-26 
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